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Preface
This preface provides information about Hyperion® and this document:

� “Purpose” on page v

� “Audience” on page v

� “Document Contents” on page vi

� “Sample Applications” on page vi

� “Conventions” on page vii

� “More Information” on page viii

� “Additional Support” on page ix

Purpose
Use this guide to help you load data from SQL, relational, and flat-file data sources
into an Essbase database. This guide explains the SQL Interface features and
options, and contains the concepts, processes, procedures, formats, tasks, and
examples that you need to use the software.

Audience
This guide is primarily for database administrators who install SQL Interface,
configure Open Database Connectivity (ODBC) drivers, and load relational data
into Essbase databases.

To use the information in this book, you need an understanding of relational
databases and ODBC drivers, and knowledge of Essbase database outlines.
� vSQL Interface Guide



Document Contents
� “Introducing SQL Interface” on page 11 provides a high-level list of steps for

using SQL Interface.

� “Configuring a Data Source” on page 15 provides information and
instructions to select and configure the correct database driver to ensure a fast
and smooth data load.

� “Preparing Multiple-Table Data for Loading” on page 25 provides
instructions to prepare data for loading into an Hyperion Essbase database.

� “Loading SQL Data” on page 29 provides information and instructions to
construct a data load rules file to map the data source to the Essbase database.

� “Using Non-MERANT ODBC Drivers” on page 49 provides information you
can use if you need to use ODBC drivers other than those supplied by Essbase.

Sample Applications
This guide provides examples based on an application called Sample, which is
provided with Essbase, and a dBASE file called budget.dbf, which is provided
with the SQL Interface software in the /app/SQL_Samp directory of your Essbase
installation.

The individual who installs the server is responsible for making Sample available
to end users. Sample contains three databases: Basic, Interntl, and Xchgrate.
Contact your Essbase system administrator if any of the following problems occur
when you connect to OLAP Server:

� You cannot find the Sample application.

� You do not have adequate access to the Sample application.

� You do not see any data in the Sample databases.

You can review a brief introduction to the Sample application in the Essbase
Installation Guide, and a longer discussion in the Essbase Database
Administrator’s Guide, Volume I.
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Conventions
Use this table to understand the conventions used in this guide:

Table i: Conventions Used in This Document

Item Meaning

Arrows indicate the beginning of a procedure consisting of
sequential steps.

Brackets [] In examples, brackets indicate that the enclosed elements
are optional.

Bold Bold text indicates words or characters that you type
exactly as they appear on the page. Bold in procedural
steps highlights major interface elements.

CAPITAL LETTERS Capital letters denote Essbase commands, functions
(except MaxL), and configuration settings. (Example:
CLEARBLOCK command)

Example text Courier font indicates that the material shown is a code or
syntax example.

Ctrl + 0 Keystroke combinations shown with the plus symbol (+)
indicate that you should press the first key and hold it
while you press the next key. Do not type the + symbol.

Courier italics Text in Courier italics indicates a variable field in
command syntax. Substitute a value in place of the
variable shown in Courier italics.

Italics Italics may be used to indicate emphasis, or a variable
whose value you should supply. Italics also mark the first
occurrence of a word that is in the glossary.

Ellipses (...) Ellipsis points indicate that text has been omitted from an
example.

Mouse orientation This document provides examples and procedures using a
right-handed mouse. If you use a left-handed mouse,
adjust the procedures accordingly.
� viiSQL Interface Guide

http://www.adobe.com


More Information
If you do not find what you need in this book, refer to the Essbase Information
Map to locate other documents provided with Essbase. The Essbase Information
Map is in the root directory of your installation CD or in the \docs\roadmap
directory of your Essbase installation. The file is essimap.htm.

For answers or comments on technical documentation, contact Hyperion Essbase
Technical Publications:

– Phone: 408.744.9500

– FAX 408.744.0400

– E-mail: TechPubs@hyperion.com

Clients in Europe, Asia, or other areas should call their local support number.

If Hyperion Software is not your software provider, contact your software
provider’s Technical Support hotline.

Menu options Options in menus are shown in the following format:
Menu name > Menu command > Extended menu command

For example: File > Desktop > Accounts

n, x The variable n indicates that you must supply a generic
number; the variable x indicates that you must supply a
generic letter.

The suffix.DLL A dynamic link library file has the suffix .dll. Your
operating system might use the term shared object or
shared library files instead.

ARBORPATH The directory path of your installation, by default
C:\Hyperion\Essbase. ARBORPATH may also
appear as $ARBORPATH for Unix and
%ARBORPATH% for Windows. If ARBORPATH
appears in italics, substitute the value from your site.

Table i: Conventions Used in This Document (Continued)

Item Meaning
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If you have a current maintenance contract with Hyperion Software, you can gain
access to Hyperion’s programs, Tech Tips, on the World Wide Web. Using Tech
Tips, you can get answer to frequently asked questions, optimization, and platform
issues using your browser. Contact your Hyperion Essbase system administrator
for your company’s access code to Tech Tips.

You can also visit these Hyperion Solutions sites for more information:

– http://www.essbase.com

– http://www.hyperion.com

Additional Support
In addition to providing the documentation and online help, Hyperion offers the
following support for product information:

� “Ordering Documentation” on page ix

� “Education Services” on page ix

� “Consulting Services” on page x

� “Technical Support” on page x

Ordering Documentation
For more information on how to order printed documentation, contact your local
consulting services office, call Hyperion Solutions Customer Support at
877.901.4975, or visit the Hyperion site: http://www.hyperion.com.

Education Services
Hyperion offers a variety of training options, including instructor-led training,
custom training, and eTraining. This education covers all Hyperion applications
and technologies and is geared to administrators, end users, and information
systems (IS) professionals.

Instructor-led training is delivered in formats and in locations suited to Hyperion’s
diverse, global customers. Hyperion Authorized Training Centers are certified
to deliver courses developed by Hyperion. Custom Education Services—training
on the configured and tailored applications that employees use on the job—is
another option to enhance user productivity and to ensure smooth day-to-day
operations. eTraining—including computer-based training, Web-based training,
� ixSQL Interface Guide
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and interactive Virtual Classroom training—provides a cost-effective means
of giving users a hands-on introduction to product features and functions.
Computer-based training (CBT) and Web-based training (WBT) provide
high-quality, self-paced training at the user’s convenience, regardless of location.

For more information about training, contact your Regional Education Manager or
visit our Web site at http://www.hyperion.com to see a list of all training
classes.

Consulting Services
Hyperion Consulting Services assists customers in maximizing the use of, and the
return on investment in, Hyperion products. Experienced Hyperion consultants
and Hyperion Alliance Partners assist organizations in tailoring solutions to their
particular requirements, such as reporting, analysis, modeling, and planning.
Specific services include implementation consulting, custom business solutions,
data integration, and technical consulting. Additionally, Hyperion offers a variety
of Services Packages and Reviews.

For more information about Consulting Services, Services Packages, and
Reviews, as well as the services offered by Alliance Partners, contact your
local consulting services representative, or visit our Web site at
http://www.hyperion.com to see a list of all Hyperion Alliance Partners.

Technical Support
Hyperion provides telephone and Web-based support to ensure that clients resolve
product issues quickly and accurately. This support is available for all Hyperion
products at no additional cost to clients with a current maintenance agreement.

� For Hyperion Solutions Customer Support, call 877.901.4975

� For Web-based support, or to see complete information on available support
options, visit our Web site at http://www.hyperion.com.
x � SQL Interface Guide
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Chapter
1

Essbase SQL Interface
Introducing SQL Interface
Use this chapter to understand SQL Interface and prepare for data loading with it:

� If you are already familiar with SQL Interface, review the changes since
Release 5 in “New Features” on page 11.

� If you need a conceptual overview of SQL Interface, see “Understanding SQL
Interface” on page 13.

� If you need to identify the steps required to load data with SQL Interface, see
“Preparing for Data Loading” on page 14.

New Features
Use this section to identify new features or changes since Release 5:

� “New for Release 6.2” on page 11

� “New for Release 6.1” on page 12

� “New for Release 6.0” on page 12

New for Release 6.2
Release 6.2 includes these improvements:

� Sample SQL Interface data source files are now located in /app/SQL_Samp
of your Essbase installation instead of in the same directory as the Sample
application, /app/Sample.

� Release 6.2 supports MERANT DataDirect ODBC drivers Version 3.6 on
Windows NT and UNIX. To view the directory structure changes for this
release, look for all MERANT driver-related files in the /ODBC directory of
your Essbase installation.
� 11Guide



Introducing SQL Interface
If you do not have the ODBC components but you have already installed SQL
Interface, you can install the ODBC components by navigating to the
\ODBC\Merant36\MDAC directory in your Essbase installation, and
double-clicking mdac_typ.exe.

New for Release 6.1
Release 6.1 includes this improvement:

As of Release 6.1, the SQL Interface installation program on Windows no longer
installs the ODBC Data Source components in the /bin directory. You will need
these components to configure your data sources.

� To verify whether you have these components installed, and if not, how to install
them, use this procedure:

1. Open your Windows control panel, and perform either of these steps:

� Check for an ODBC Data Sources icon in Windows NT.

� Double-click the Administration Services icon in the Control Panel,
double-click the Data Sources icon and check for ODBC drivers.

2. If you do not have the ODBC components, you can download Microsoft Data
Access Components (MDAC) from the following Web site:

http://www.microsoft.com/data/MDAC21info/manifest_intro.htm

New for Release 6.0
Release 6.0 includes these improvements:

� SQL Interface runs on HP-UX and Windows 2000, as well as on AIX, Solaris,
and Windows NT.

� As of Release 6, Essbase SQL Drill-Through is no longer provided, so you
may need to use a previous release of SQL Drill-Through.

To use a previous release of SQL Drill-Through with Release 6.x, do the
following:

a. Install Essbase Spreadsheet Add-in, Release 6.x

b. Install Essbase SQL Drill-Through, Release 5.0.2 Patch 9 (or later), in the
same directory.
12 � Essbase SQL Interface Guide
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Introducing SQL Interface

1

For information on the data sources qualified for use with Essbase on Windows
NT and UNIX platforms, see the Essbase Installation Guide, file essinst.pdf
in the /docs/pdf directory of your Essbase installation, or the readme.txt file
in the root directory of your Essbase installation.

Note: You can also load data from spreadsheets and text files directly, using
Application Manager. See the Essbase Database Administrator’s
Guide.

Understanding SQL Interface
Use SQL Interface to load data directly from a number of popular SQL, relational,
and flat-file database servers. SQL Interface provides the connection you need to
accomplish these tasks:

� You can execute SQL statements on data before loading. For example, this
allows you to load summary data instead of the entire contents of your source
database.

� Optionally, you can build Essbase dimensions dynamically as you load data.

� You can load data from flat files that are in ASCII text format, as well as
connecting directly to your relational source database.

Note: You can load data from spreadsheets or text files using Application
Manager without the use of SQL Interface. See the Essbase Database
Administrator’s Guide.

SQL Interface works with Application Manager to retrieve data using this
procedure:

1. You write a SELECT statement in SQL using Application Manager.

2. SQL Interface passes it to the SQL or relational database server. For non-SQL
data sources, SQL Interface converts SQL statements to requests for data that
the source understands.

3. SQL Interface interprets the records received from the SQL, relational, or
flat-file database server using the rules defined in the data load rules file. (For
more information on data load rules files, see Chapter 4, “Loading SQL
Data.”)

4. SQL Interface loads the interpreted, summary-level data into the Essbase
database.
� 13Essbase SQL Interface Guide



Introducing SQL Interface
Preparing for Data Loading

� To prepare to use SQL Interface to load SQL, relational, or flat-file data, use this
procedure:

1. Install SQL Interface on your Essbase machine, either during or after your
OLAP Server installation. See the Essbase Installation Guide for instructions.

2. Choose your ODBC driver and point it to its data source. See Chapter 2,
“Configuring a Data Source.”

3. If your data is in multiple tables, prepare the data for loading by doing either
of these actions:

� Create one table or view in your SQL database before using SQL
Interface.

� Join the tables during the data load by entering a SELECT statement in
Application Manager.

See “Understanding Multiple-Table Preparation” on page 25 for instructions.

4. Check that you can connect to the data source by using the Data Prep Editor
in Application Manager to open the SQL source file. See Chapter 4, “Loading
SQL Data.”

5. Create a data load rules file to tell SQL Interface how to interpret and load
the SQL data into your Hyperion Essbase database. See Chapter 4, “Loading
SQL Data.”

After these steps are complete, you can load your data. See Chapter 4, “Loading
SQL Data” for instructions.
14 � Essbase SQL Interface Guide



Chapter
2

Essbase SQL Interface
Configuring a Data Source
Before you can access data using SQL Interface, you must select a data source and
the driver it requires. The procedure depends on your operating system:

� “Configuring a Data Source on Windows” on page 15

� “Example: Creating a Data Source on Windows NT” on page 16

� “Configuring a Data Source on UNIX” on page 23

Note: For detailed, driver-specific information on each of the MERANT drivers, see the
MERANT DataDirect Connect ODBC Reference in the /ODBC/Merant36/Docs
directory of your Essbase installation.

Configuring a Data Source on Windows
On Windows, use the ODBC Administrator to configure the data source.

� To configure the ODBC Administrator, use this procedure:

1. Start ODBC Administrator, using either of these methods:

� Open the Windows Control Panel.

– For NT, double-click the ODBC Data Sources icon, if one exists. If
it does not, use the other method in this list.

– For Windows 2000, double-click the Administrative Services icon,
then double-click the Data Sources icon.

� At the Windows NT command prompt, type the appropriate path to the
file ODBCAD32.EXE, which you typically can find in the Windows
system directory. For example:

C:\WINNT\SYSTEM32\ODBCAD32
� 15Guide



Configuring a Data Source
If you do not have the ODBC components, look for the installation program
mdac_typ.exe in \ODBC\Merant36\MDAC in your Essbase installation.

2. Choose a data source, or add one, and then enter the required information
about the driver.

For detailed instructions, see the appropriate driver chapter in the MERANT
DataDirect Connect ODBC Reference (for example, “Connect ODBC for
dBASE,” or “Connect ODBC for Oracle”).

For an examples, see the example appropriate for your operating system:

– “Example: Creating a Data Source on Windows NT” on page 16.

– “Example: Creating a Data Source on Windows 2000” on page 19

Example: Creating a Data Source on Windows NT

� To configure the dBASE data source, complete the following steps:

1. Start the ODBC Administrator, using the instructions in step 1 in “Configuring
a Data Source on Windows” on page 15.

2. Click the User DSN tab in the ODBC Data Source Administrator dialog
box.
16 � Essbase SQL Interface Guide



Configuring a Data Source

2

3. Click Add on the User DSN page.

The Create New Data Source dialog box is displayed.

4. From the list box, select MERANT OEM 3.60 32-bit dBASEFile (*.dbf)
and click the Finish button to display the General tab of the ODBC dBASE
Driver Setup dialog box.

5. Type the following information on the General tab:

a. In the Data Source Name text box, type dBASEFiles.
� 17Essbase SQL Interface Guide



Configuring a Data Source
b. In the Description text box, type Load Files.

c. In the Database Directory text box, type
c:\hyperion\essbase\app\SQL_Samp. If you installed Essbase
in the default directory, c:\hyperion\essbase, budget.dbf is stored
in this subdirectory. If you installed it elsewhere, substitute your site’s
value for c:\hyperion\essbase.

d. Click OK.

The User DSN tab of the ODBC Data Source Administrator dialog box
is displayed with dBASEFiles listed in the User Data Sources list box:

6. Click OK to close the ODBC Data Source Administrator.
18 � Essbase SQL Interface Guide



Configuring a Data Source

2

If you need help during the procedure, use the online help. For example, clicking
the Help button on the General tab of the ODBC dBASE Driver Setup dialog
box (in step 4) brings up a Help screen:

Different help topics are available from different dialog box Help buttons.

Example: Creating a Data Source on Windows 2000

� To configure the dBASE data source, complete the following steps:

1. Start the ODBC Administrator, using the instructions in step 1 in “Configuring
a Data Source on Windows” on page 15.
� 19Essbase SQL Interface Guide



Configuring a Data Source
2. Click the User DSN tab in the ODBC Data Source Administrator dialog
box:

3. Click Add on the User DSN page.

The Create New Data Source dialog box is displayed.
20 � Essbase SQL Interface Guide



Configuring a Data Source

2

4. From the list box, select MERANT OEM 3.60 32-BIT dBASEFile (*.dbf)
and click the Finish button to display the General tab of the ODBC dBASE
Driver Setup dialog box:

5. Type the following information on the General tab:

a. In the Data Source Name text box, type dBASEFiles.

b. In the Description text box, type Load Files.

c. In the Database Directory text box, type
c:\hyperion\essbase\app\SQL_Samp. If you installed Essbase
in the default directory, c:\hyperion\essbase, budget.dbf is
stored in this subdirectory. If you installed it elsewhere, substitute your
site’s value for c:\hyperion\essbase.

d. Click OK.
� 21Essbase SQL Interface Guide



Configuring a Data Source
The User DSN tab of the ODBC Data Source Administrator dialog box
is displayed with dBASEFiles listed in the User Data Sources list box:

6. Click OK to close the ODBC Data Source Administrator.

If you need help during the procedure, use the online help. For example, clicking
the Help button on the General tab of the ODBC dBASE Driver Setup dialog
box (in step 4) brings up a Help screen:

Different help topics are available from different dialog box Help buttons.
22 � Essbase SQL Interface Guide
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Configuring a Data Source on UNIX
The ODBC Administrator is not available on UNIX platforms. SQL Interface
generates the.odbc.ini file upon installation, and you do not need to do any
further configuration to use the budget.dbf file.

If you add data sources or drivers, you may need to edit the.odbc.ini file:

� “Understanding the .odbc.ini File” on page 23

� “Editing the .odbc.ini File for Changes” on page 23

� “Example: Editing .odbc.ini for Oracle 8” on page 23

Understanding the .odbc.ini File
The .odbc.ini file contains the ODBC connection and configuration
information, such as data source name and driver product name. Specific
information varies among platforms. The file and format are defined by the
Microsoft ODBC specification.

Editing the .odbc.ini File for Changes
Because the.odbc.ini file maps data source names to driver products, you must
edit the.odbc.ini file if you add a new driver product or data source or change
driver products or data sources.

Example: Editing .odbc.ini for Oracle 8
Here is the entry you make in the.odbc.ini file for the Oracle 8 driver (assuming
you installed to home/hyperion/essbase):

[ODBC Data Sources]
Oracle8=MERANT 3.60 Oracle 8 Driver

[Oracle8]
Driver=/home/hyperion/essbase/dlls/ARor815.so
Description=Oracle8
ServerName=name

Substitute for name the Oracle server name appropriate for your site.

For more information about the.odbc.ini file, see the MERANT DataDirect
Connect ODBC Reference in the ODBC/Merant36/Docs directory of your
Essbase installation.
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3

Essbase SQL Interface
Preparing Multiple-Table Data
for Loading
This section tells you how to prepare relational data in multiple tables for loading
into Essbase:

� “Understanding Multiple-Table Preparation” on page 25

� “Preparing Data from Multiple Tables” on page 28

If all your data is in one table, skip to Chapter 4, “Loading SQL Data.”

Understanding Multiple-Table Preparation
Use this section to understand the two methods available for preparing multi-table
data:

� “Understanding Two Methods for Multiple-Table Data Preparation” on
page 26

� “Understanding Security Requirements” on page 27

� “Choosing a Preparation Method” on page 27
� 25Guide



Preparing Multiple-Table Data for Loading
Understanding Two Methods for Multiple-Table Data
Preparation

If data is in multiple tables, create a single table or a view of the data in either of
the following ways:

� Create one table or view in the SQL database before using SQL Interface:

See “Choosing a Preparation Method” on page 27 for instructions.
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3

� Join the tables by entering a SELECT statement in Application Manager
during the data load:

See “Preparing Data from Multiple Tables” on page 28 for instructions.

The SQL data source file must always be accessible to OLAP Server. Make sure
that the SQL data source file resides on the computer where OLAP Server is
installed, or on the network.

Choosing a Preparation Method
A SQL database server reads from a single table and maintains a single view more
efficiently than it processes a multiple-table SELECT statement. Therefore,
creating a single table or view before you use SQL Interface greatly reduces the
amount of processing time the SQL server needs.

Understanding Security Requirements
Data load preparation requires specific permissions:

� For any data load preparation method, you need SELECT access privileges to
all tables containing the relevant data.
� 27Essbase SQL Interface Guide



Preparing Multiple-Table Data for Loading
� For creating a single table or view in the relational database source, you need
CREATE access privileges in the SQL database to create a single table or
view. Ask the SQL Database Administrator to provide you with the
appropriate CREATE privileges.

If you cannot obtain CREATE privileges, use Application Manager to join
tables during the data load. See “Preparing Data from Multiple Tables” on
page 28 for instructions.

Preparing Data from Multiple Tables

� Use this process to prepare data from multiple tables:

1. Obtain the required privileges:

– SELECT access to all tables where relevant data is stored

– CREATE access to create a single table or view to join multiple-table data
before using SQL Interface

2. Use one of these methods to prepare data from multiple tables:

– Create a single physical table or virtual table (view) based on data from
multiple tables in the source database.

– Create a SELECT statement in Application Manager that joins the tables:

i. Identify the tables and columns (or fields) containing the data that you
want to load into Essbase.

ii. Select File > Open SQL in the Application Manager Data Prep
Editor to display the Define SQL dialog box. For more information,
see “Step 1: Opening the Data Prep Editor” on page 31.

iii. Write a SELECT statement that joins the tables. For more
information, see “Step 2: Selecting the SQL Data Source” on page 32
and “Creating SQL Queries” on page 34.

Note: Essbase passes the SELECT statement to SQL Server without verifying the
syntax.
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Chapter
4

Essbase SQL Interface
Loading SQL Data
This chapter describes how to load SQL data into OLAP Server using Application
Manager:

� “Understanding Loading Data” on page 29

� “Creating a Data Load Rules File” on page 29

� “Loading the Data” on page 46

Examples in this section are based on the Sample application and Basic database
and the dBASE data file budget.dbf, which is installed with SQL Interface in the
/app/SQL_Samp directory of your Essbase installation. This file contains budget
data for the West and the East regions of a fictitious company. For more
information on the sample applications, see “Sample Applications” on page vi.

Understanding Loading Data
After you have configured the data source and prepared the multiple-table data for
loading, load the data in two steps:

1. Create a data load rules file. See “Creating a Data Load Rules File” on page 29
for instructions.

2. Load data into the Essbase database. See “Loading the Data” on page 46 for
instructions.

Creating a Data Load Rules File
To load SQL data into the Essbase database, you must create and use a data load
rules file.
� 29Guide



Loading SQL Data
Data load rules are a set of operations that Essbase performs on data when it loads
it into an Essbase database. The operations are stored in a rules file that tells
Essbase how to load the SQL data and map it to your database outline. The rules
file can also reject invalid records in the data source.

You can reuse a rules file with any data source that needs the same set of data
load rules.

Summary of Steps to Create a Data Load Rules File
To create a data load rules file, follow these steps:

1. Open the Data Prep Editor. See “Step 1: Opening the Data Prep Editor” on
page 31 for instructions.

2. Select the SQL data source, budget.dbf in the example. See “Step 2:
Selecting the SQL Data Source” on page 32 for instructions.

3. Define the data load rules in a rules file. See “Step 3: Defining the Data Load
Rules” on page 38 for instructions.

4. Associate the data load rules file with the database outline, Sample Basic in
the example. See “Step 4: Associating the Rules File with an Outline” on
page 43 for instructions.

5. Validate the data load rules file. See “Step 5: Validating the Rules File” on
page 44 for instructions.

6. Save the data load rules file. See “Step 6: Saving the Rules File” on page 45
for instructions.
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4

Step 1: Opening the Data Prep Editor

� To open the Data Prep Editor:

1. Start Application Manager and connect to your server. The Application
Manager Desktop window is displayed:

2. From the Applications list box, select Sample.

3. From the Databases list box, select Basic.

4. Click the Data Load Rules button, . The existing data load rules are
listed in the Desktop Window, and the New button becomes active.
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5. Click New to display the Data Prep Editor:

Step 2: Selecting the SQL Data Source

� To select the data source, budget.dbf in the sample screens, use this procedure:

1. Choose File > Open SQL:

Note: This is the point where SQL Interface is first invoked.
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The Select Server, Application and Database dialog box is displayed. The
Sample Basic database is selected:

2. Click OK to display the Define SQL dialog box:

In the SQL Data Sources list box, dBASE Files is selected. This is the SQL
source that you configured in Chapter 2, “Configuring a Data Source.”

The wildcard character (*) appears in the Select text box. This loads all the
fields from the dBASE file.

3. Type the name of the data source file in the From text box (budget.dbf in
this example). You defined the path for this file in Chapter 2, “Configuring a
Data Source,” so you do not need to define it here.

Leave the Where text box empty to load all the rows from the table.

4. Click OK/Retrieve.
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Essbase opens the data source file, budget.dbf, in the Data Prep Editor.
See “Step 3: Defining the Data Load Rules” on page 38 for more information.

Note these facts about data source files:

– The data source file must be stored on OLAP Server, not on the client
machine.

– On UNIX platforms, if you have defined the path for the SQL data source
file in the.odbc.ini file, you can either enter that path or a different path
in the Database text box of the Define SQL dialog box.

– On Windows, if you have not defined the path for the SQL source file in
the ODBC Administrator, you can type the path in the Database text box
of the Define SQL dialog box.

– If you do not define a path, Essbase looks for the data source file in the
directory from which you are running OLAP Server.

Creating SQL Queries
If you have not created a table or view to retrieve only the information you need
from your data source, you can write a SELECT statement to achieve this goal.

Note: Creating a SELECT statement in Application Manager is usually slower than
creating a table or view in the source database.

The Define SQL dialog box has Select, From, and Where text boxes to help you
write SQL queries. You can specify multiple data sources, filter the display of
records, and specify the desired order and grouping of records that will appear in
the Data Prep Editor.

The rest of this section contains examples of queries used for data preparation. You
can review these examples for help with your site or skip to the next step:

� “Example: Selecting Fields and Records from a Table” on page 35

� “Example: Querying Data from Two Tables” on page 35

� “Example: Order By with No Where Clause” on page 36

� “Example: Order By with a Where Clause” on page 36

� “Example: Group By with No Where Clause (Incorrect)” on page 37

� “Example: Group By with a Where Clause (Correct)” on page 38
34 � Essbase SQL Interface Guide



Loading SQL Data

4

Example: Selecting Fields and Records from a Table

The example in “Step 2: Selecting the SQL Data Source” on page 32 uses the
wildcard character (*) in the Select text box to load data from all the fields
(columns) in the dBASE file. Alternatively, you can type the names of all the
fields:

VERSION,PRODNO,STATE,ACCOUNT,MONTH,MEASURE

Or, you can type only the names of the fields that you want to load, for example:

PRODNO,STATE,MONTH

The example in “Step 2: Selecting the SQL Data Source” on page 32 also uses the
name of a single dBASE file (BUDGET.DBF) in the From text box, and leaves the
Where text box empty.

You can also use the Where text box to choose a subset of records (rows) to load
from the SQL source files.

� To load only records (rows) for January from budget.dbf into the Sample Basic
database,

1. Type the following text in the From text box:

budget.dbf

2. Type the following text in the Where text box:

MONTH = "Jan"

3. Click OK/Retrieve.

Example: Querying Data from Two Tables

If you are loading data from two relational tables, you can join the tables by
specifying both of the table names, separated by a comma (,) in the From text box,
and specifying the common (key) fields in the Where text box, separated by an
equal sign (=).

� To load data from two tables, table1.dbf and table2.dbf, where the Key_No
field of table1.dbf contains the same data as the Key_Code field of
table2.dbf:

1. Type the following text in the From text box:

TABLE1.DBF,TABLE2.DBF
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2. Type the following text in the Where text box:

TABLE1.Key_No = TABLE2.Key_Code

3. Click OK/Retrieve.

Example: Order By with No Where Clause

This SQL statement will query all columns from the relational source, and will sort
the results in month order:

Example: Order By with a Where Clause

This SQL statement will return rows from the relational source where the State
column is equal to New York, California, or Nevada. It will sort the results in
month order:
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Example: Group By with No Where Clause (Incorrect)

This SQL statement will return one row per Prodno, State, Account, and Month. It
will summarize the metric contained in the Measure column, producing incorrect
results:

Now assume that budget.dbf looks like this table:

Table 1: Abbreviated Data Source Example

The SQL statement returns these results:

100-10, New York, Sales, Jan, 800

Budget and Actual data have been added together, which is not the intended result.
See the next example for an approach that produces correct results.

Version Prodno State Account Month Measure

Budget 100-10 New York Sales Jan 500

Budget 100-10 New York Sales Jan 200

Actual 100-10 New York Sales Jan 100
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Example: Group By with a Where Clause (Correct)

This SQL statement will select only records that have a Version of Budget and a
State equal to New York, California, or Nevada:

This SQL Statement will return one row per Prodno, State, Account, and Month.
It will summarize the metric contained in the measure column.

Assume that budget.dbf looks like Table 1. The SQL statement returns these
results:

100-10, New York, Sales, Jan, 700

See the MERANT DataDirect Connect ODBC Reference for more information
about SQL statements for your specific driver.

Step 3: Defining the Data Load Rules
When you click OK/Retrieve in the Define SQL dialog box, Essbase displays the
dBASE fields in the Data Prep Editor. Notice that the field names from the data
source differ from the Sample Basic dimension names:
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Edit the field names and properties to match:

� “Changing Field Names” on page 39

� “Changing Field Properties” on page 41

Changing Field Names

� To change the field names to match the dimension names in the Essbase outline
(Sample Basic in the sample screens), use this procedure:

1. After completing “Step 3: Defining the Data Load Rules” on page 38, select
the first cell in the first field (VERSION) and choose Field > Properties from
the Application Manager menu:
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The Field Properties dialog box is displayed:

2. Select the Data Load Properties tab.

The data load properties for Field Number 1 are displayed.

3. In the Field Name text box, highlight VERSION and type the dimension name
Scenario over it, and click Next.

The data load properties for Field Number 2 are displayed.

4. Type Product over the existing name (PRODNO) and click Next.

The data load properties for Field Number 3 are displayed.

5. Type Market over the existing name (STATE) and click Next.

The data load properties for Field Number 4 are displayed.

6. Type Measures over the existing name (ACCOUNT) and click Next.

The data load properties for Field Number 5 are displayed.

7. Type Year over the existing name (MONTH) and click Next.

The data load properties for Field Number 6 are displayed. This is the
last field in budget.dbf. It contains data values. Because you have fully
specified each dimension, you do not match this field to a dimension name.

8. Delete the existing name (MEASURE) in the Field Name text box and leave the
box blank.

9. Click OK to save all your changes.
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The Data Prep Editor is displayed again with the fields renamed. Notice that
the last column has a temporary name of field 6:

Changing Field Properties
The fields in the data source file may contain unnecessary leading and trailing
white spaces.

� To ensure that Essbase deletes these white spaces in each of the fields when it loads
the data, use this procedure:

1. After completing “Step 3: Defining the Data Load Rules” on page 38, select
the first cell in the first field (Scenario) and choose Field > Properties from
the Application Manager menu:
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2. Click the Global Properties tab:

3. Select the Drop leading/trailing whitespace check box if it is not already
checked.

4. Click Next, and select Drop leading/trailing whitespace for all fields.

5. When you reach Field 6, select the Data Field check box as well as Drop
leading/trailing whitespace, to tell Essbase that this field contains data
values:

6. Click OK to close the Field Properties dialog box.

You have defined the data load rules for the dBASE file. For more information on
creating data load rules files, see the Essbase Database Administrator’s Guide.
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Step 4: Associating the Rules File with an Outline

� To associate the rules file with the Sample Basic outline, use this procedure:

1. Choose Options > Associate Outline:

The Associate Server Outline Object dialog box is displayed:

2. From the Objects list box, select BASIC and click OK.
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Step 5: Validating the Rules File

� To validate the rules file against the Sample Basic outline:

1. Choose Options > Validate:

If Essbase can validate the rules file, it displays the Verify message box:

If there are validation problems, Essbase displays the problems in a Validate
Rules dialog box. If a field has validation problems, ensure that the field name
is correct. For more information on validating rules files, see the Essbase
Database Administrator’s Guide.

2. Click OK to close this message box.
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Step 6: Saving the Rules File

� Use this procedure to save the rules file:

1. Choose File > Save:

The Save Server Object dialog box is displayed:

2. In the Object Name text box, type BUDGET.

This gives the rules file the name BUDGET.RUL.

3. Click OK.

4. Choose File > Close to close the Data Prep Editor.
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You can now use the BUDGET rules file to load the data from the dBASE file into
the Sample Basic database.

Loading the Data

� To load the data into Sample Basic:

1. In the Application Desktop Window, select the Sample application and the
Basic database.

2. Choose Database > Load Data to display the Data Load dialog box:

3. In the Type group of the Data Load dialog box, select the SQL option.

4. Select the Use Rules check box.
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5. Click Find to display the Open Server Rules Object dialog box:

6. Ensure that the Sample application and Basic database are selected.

7. Choose the BUDGET rules file from the Objects list box.

8. Click OK to display the Data Load dialog box again.

9. In the Options group, select the Load Data and Abort On Error during
dataload check boxes. Ensure that all other options in the group are not
selected:
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10. Click OK to load the data.

You may need to type an SQL user name and SQL password when you
connect to some SQL databases (for example, when you connect to an Oracle
database). You do not need to enter a user name and password when you
connect to a dBASE database.

When Essbase has loaded the data, a message box tells you that the load was
successful:

11. Click OK to close the message box.

Essbase loads the SQL data into the Sample Basic database. The dBASE file
contains budget data for the West and the East regions. Essbase loads the data into
member combinations for these regions. If you have problems loading the data, see
the Essbase Database Administrator’s Guide for information on data loading or
troubleshooting.
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Essbase SQL Interface
Using Non-MERANT ODBC
Drivers
You can use ODBC database drivers with Essbase other than the MERANT
drivers provided with SQL Interface. For example, you can use a Microsoft ODBC
driver to connect to Microsoft Access, or use an IBM ODBC driver to connect to
IBM DB2/6000. Some non-MERANT ODBC drivers are tested with Essbase. For
more information on tested and supported drivers and data sources, see the
Essbase Installation Guide or the readme.txt file.

To use a non-MERANT driver, you need to:

1. Configure the driver.

2. Configure the data source.

This chapter contains the following topics that describe how to use non-MERANT
ODBC drivers:

� “Configuring a Non-MERANT Driver” on page 49

� “Creating a Configuration File for Non-MERANT Drivers” on page 50

� “Configuring Non-MERANT Data Sources” on page 56

� “Support for Non-MERANT Drivers” on page 60

Configuring a Non-MERANT Driver
When you configure a MERANT driver, Essbase recognizes the basic
configuration information for the driver, especially the name of the driver and
whether the name and password are case-sensitive. However, when you use a
non-MERANT driver, you must give Essbase the configuration information for
the driver that you use.
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You give Essbase the configuration information for your non-MERANT driver by
creating a driver configuration file called esssql.cfg, which is an ASCII text
file. Place this file in your ARBORPATH\BIN directory on OLAP Server. This is
C:\HYPERION\ESSBASE\ if you installed Essbase in the default directory
(/home/hyperion/essbase/ on UNIX platforms).

Note: If you do not create a configuration file, Essbase uses its own default values. You
may not be able to connect to the SQL database using the default values.

Creating a Configuration File for Non-MERANT
Drivers

The configuration file must contain at least some of the following configuration
values for each non-MERANT ODBC driver that you use. Required values may
be different for different drivers. See the online help for each driver or see the
documentation for specific information.

This section contains information about what you need to include in the
configuration file, and in one case, how to find it:

� “Including the Minimum Required Contents” on page 50

� “Finding a Driver Name on Windows” on page 53

� “Finding a Driver Name on UNIX” on page 54

� “Example: Creating a Configuration File for the MS Access Driver on
Windows” on page 54

� “Example: Creating a Configuration File for the IBM DB2 Driver on AIX” on
page 55

Including the Minimum Required Contents
At a minimum, your configuration file must contain at least the DriverName for
every non-MERANT ODBC driver that you use. Surround all values for each
driver with brackets ([]). Leave one or more spaces between the configuration
keyword and its corresponding value.
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Use this template to help you create a configuration file:

[

Description "Description of Driver"
DriverName DriverName
UserId Value
Password Value
Database Value
Server Value
Application Value
Dictionary Value
Files Value
SingleConnection Value
UpperCaseConnection Value
IsQEDriver Value
]

Description of Driver is your description of the driver. Enclose the description in
quotation marks (""). The default value is "".

DriverName is the file name of the non-MERANT ODBC driver and is required.

For all other configuration keywords, set Value to be either 1 or 0, according to is
table:

Configuration
Information Value Description

UserId 1 User ID required.

0 User ID not required. Default: 0

Password 1 Password required.

0 Password not required. Default: 0

Database 1 Database name required.

0 Database name not required. Default: 0

Server 1 Server name required.

0 Server name not required. Default: 0

Application 1 Application name required.

0 Application name not required. Default: 0
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The defaults apply if you do not specify the value for the driver. These defaults are
different from the Essbase default values that apply if you do not create an
esssql.cfg file.

Include configuration information for all the non-MERANT drivers in one
configuration file. Enclose the values for each driver in brackets ([])

Dictionary 1 Dictionary name required.

0 Dictionary name not required. Default: 0

Files 1 Files name required.

0 Files name not required. Default: 0

SingleConnection 1 Driver not thread-safe. One active connection
allowed. Default: 1

Recommendation for MERANT drivers: 1

0 Driver thread-safe. Multiple active connections
allowed.

CAUTION: Specifying 0 (multiple active
connections allowed) for MERANT or
non-MERANT drivers may lead to instability.

UpperCaseConnection 1 Driver not case-sensitive. Connection
information is converted to uppercase.

0 Driver case-sensitive. Connection information is
unchanged. Default: 0

IsQEDriver 1 Driver is a MERANT driver. You can specify
configuration information for MERANT
drivers (for example, if you have a later version
of an MERANT driver which Essbase does not
yet support).

0 Driver is a non-MERANT driver. Default: 0

Configuration
Information Value Description
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Use this template to help you create a configuration file:

[
Description "Description of Driver"
DriverName DriverName
...
]

[
Description "Description of Driver"
DriverName DriverName
...
]

Finding a Driver Name on Windows

� To display the name of the drive, use this procedure:

1. Start the ODBC Administrator using any method from step 1 in “Configuring
a Data Source on Windows” on page 15. If you do not have the ODBC
components, see “What’s New in Release 6.2” on page xi for information
about obtaining them.

The ODBC Data Source Administrator dialog box, User DSN tab appears:

Data sources that you have configured are in the User Data Sources list box.
Drivers that have not been properly configured may also be in the User Data
Sources list box. Ignore them.
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2. Select the Drivers tab to display the Drivers screen:

3. Obtain the file name of the driver by scrolling to the right. For example, the
file name for the Microsoft Access Driver is ODBCJT32.DLL.

4. Click OK when you have selected the driver.

For more information on the ODBC Administrator, see “Configuring an MS
Access Data Source on Windows” on page 56.

Finding a Driver Name on UNIX
On UNIX, the driver’s name is in the.odbc.ini file. For more information on
the .odbc.ini file, see “Configuring a Data Source on UNIX” on page 23.

Example: Creating a Configuration File for the MS Access
Driver on Windows

The driver name for the Microsoft Access driver on Windows is ODBCJT32.DLL.
This driver requires a database name, server name, application name, and
dictionary (directory path). This driver is not a MERANT driver, so you must
create a type its configuration file, esssql.cfg in ASCII-text format.
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Use this example as a template:

[

Description "Microsoft Access Driver (*.MDB)"
DriverName ODBCJT32.DLL
Database 1
Server 1
Database 1
Application 1
Dictionary 1
IsQEDriver 0
]

Note: See “Configuring an MS Access Data Source on Windows” on page 56.

Example: Creating a Configuration File for the IBM DB2
Driver on AIX

The driver name for the IBM DB2/6000 driver on AIX is DB2.0. This driver
requires a user ID, password, and database name, but not a server name. This
driver is thread-safe and case-sensitive. It is not a MERANT driver, so you must
create a configuration file, esssql.cfg, in ASCII-text format.

Use this example as a template:

[
Description "IBM DB2/6000 ODBC Driver"
DriverName DB2.0
UserId 1
Password 1
Database 1
SingleConnection 0
UpperCaseConnection 0
IsQEDriver 0
]

Note: See “Configuring an IBM DB2 Data Source on AIX” on page 60.
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Configuring Non-MERANT Data Sources
Configure a non-MERANT data source in the same way that you configure a
MERANT data source. See Chapter 2, “Configuring a Data Source” for more
information. The following sections tell you how to configure a Microsoft Access
data source on Windows NT and an IBM DB2/6000 data source on AIX:

� “Configuring an MS Access Data Source on Windows” on page 56

� “Configuring an IBM DB2 Data Source on AIX” on page 60

Note: Before you configure a non-MERANT data source, you must first configure the
driver by creating an esssql.cfg configuration file. See “Creating a Configuration
File for Non-MERANT Drivers” on page 50.

Configuring an MS Access Data Source on Windows
The following example describes how to configure a Microsoft Access data source
on OLAP Server on Windows. Your data source and driver may differ, but the
steps that you take to configure the data source are essentially the same. The
example assumes:

� You have installed the Microsoft Access ODBC 32-bit database driver on
OLAP Server.

� OLAP Server has access to a sample Microsoft Access (*.MDB) file.

On Windows, use the ODBC Administrator, ODBCAD32.EXE, to configure
a non-MERANT data source, just as you use it to configure a MERANT data
source.

This example uses the ORDERS.MDB file, which is installed with Microsoft Access,
but you can use any .MDB file to test the data source configuration.

The Microsoft Access ODBC 32-bit database driver is also installed with
Microsoft Access, but it can be installed in other ways. For Microsoft Access, you
need to specify the data source name and database. You can also provide a
description. Other ODBC drivers may require additional information. See the
documentation for each driver, and online help, for what is required.

� To configure the Microsoft Access data source:

1. Start the ODBC Administrator in either of the ways described in step 1 of
“Configuring a Data Source on Windows” on page 15.
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The User DSN tab of the ODBC Data Source Administrator dialog box is
displayed:

Data sources that you have previously configured are displayed in the User
Data Sources list box. Drivers that have not been properly configured may
also be in the User Data Sources list box. Ignore or remove them.

2. Click Add to display the Create New Data Source dialog box:
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3. Scroll down the list of available drivers and select Microsoft Access
Driver (*.mdb).

4. Click Finish to display the ODBC Microsoft Access 97 Setup dialog box.

5. Type MSAccess Orders, or any name that will help you identify the source,
in the Data Source Name text box.

6. Type Load Data in the Description text box.

7. Click Select in the Database group to display the Select Database dialog box.

8. Locate and select ORDERS.MDB (or the name of your.MDB file).
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9. Click OK. The ODBC Microsoft Access 97 Setup dialog box is displayed
with the path and file that you selected.

10. Click OK to display the ODBC Data Source Administrator dialog box.

The Microsoft Access data source is in the User Data Sources list box, with
other data sources that may or may not have been configured.

11. Click OK.
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You can now load data from the Microsoft Access data source file that you chose
into a Essbase database. For information on loading SQL data, see Chapter 4,
“Loading SQL Data.” For general information on loading data, see the Essbase
Database Administrator’s Guide.

Note: Remember that source files must be accessible to OLAP Server. They can be on
the OLAP Server machine or on the network.

Configuring an IBM DB2 Data Source on AIX
If you use AIX, you can connect to an IBM DB2/6000 data source using the IBM
DB2/6000 ODBC driver. Consult the database administrator for information on
configuration, authorization, binding, and other steps that may be required to
connect to the data source.

Note: See “Example: Creating a Configuration File for the IBM DB2 Driver on AIX” on
page 55.

Support for Non-MERANT Drivers
Some non-MERANT drivers are not tested or supported for use with Essbase. The
driver that you choose might not be specifically tested to work with Essbase. For
information on qualified drivers and data sources, see the Essbase Installation
Guide.
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